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A QUICK HOWDY
 

P H O T O G R A P H :  D A N  S A E L I N G E R  |  I L LU S T R AT I O N:  R A N D A L L  WAT S O N

No Monkey 
Business
•  TWO TERMS—stimulus and group-
think—may have injected optimism 
into the markets. But in an already-rag-
ing bull market, excess optimism war-
rants caution. As the “reopening trade” 
signaled pent-up demand for anything 
associated with leaving our homes and 
returning to “normal” (whatever that 
means now), we saw bouts of eupho-
ria in the markets. And it caught the 
attention of traders and Wall Street. 
Although some will say what we’ve 
seen looks like the late 1990s before it 
all burst, history doesn’t necessarily 
repeat itself. But it can open the flood-
gates for a new breed of traders chas-
ing the next set of story stocks.    

And that’s the rub with the stock 
market—you never really know where 
the truth lies in relation to value. Get 
too complacent and the market can 
turn against you. No matter what so-

cial media is murmuring or the pundits 
are spewing, there’s no substitute for 
due diligence. Trading decisions as 
well as long-term investing choices 
need to align with your financial goals. 
It’s really about your relationship with 
the market and knowing what triggers 
a trading signal for you. And before 
you forge ahead, it’s important to have 
an exit plan in place.

Easier said than done? The good 
news is there are several ways to do 
this. Think about what’s important to 
you and how to achieve it. What type of 
risk management strategies align well 
with your goals? Maybe you use charts 
and place stop orders based on break-
out levels, Fibonacci retracements, or 
trendlines. In the heat of the moment, 
it’s easy to lose your focus. You could 
turn a perfect setup upside down and 
end up with a loss. What could possibly 
happen to your can’t-lose, six-indicator, 
oscillation-channeling-stochastinator 
setup? Take a look at “The Five Biggest 
Charting Mistakes You’re Probably 
Making” on page 16. These tips could 
go a long way to help you avoid making 
embarrassing charting faux pas.   

We spend a lot of time thinking about 
what to do when a trade goes wrong, 
but what if your trade’s going right and 
reaches its profit target? Should you get 
out even if you think you could squeeze 
some more returns from the trade? Gut 
instinct is cool if it got you here, but 
lightning rarely strikes twice. You can 
flip to “How to Exit a Trade (Without 
Losing Your Mind)” on page 20 to learn 
some options strategies that could help 
you lock in profits without leaving mon-
ey on the table. 

Savvy traders embrace volatility and 
whatever the markets offer them. Part 
of their plan is to actually have a plan 
and stick to it. Exuberant markets can be 
fun on the way up, but in the end, it’s not 
about how much you make; it’s about 
how much you keep. Plan your exits, 
win or lose, and you’ll be ready to trade 
the new normal.

     Happy trading, 
           Kevin Lund
           Editor-in-Chief, thinkMoney

TALK TO US—Nay, shout out to us (with email, please). Seriously, let us know 
what you think about thinkMoney. Write to us at thinkmoney@tdameritrade.com
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DISCLAIMERS
IMPORTANT INFORMATION YOU NEED TO KNOW

The information presented in this pub-
lication does not consider your personal 
investment objectives or financial 
situation; therefore, this publication 
does not make personalized recom-
mendations. This information should 
not be construed as an offer to sell or 
a solicitation to buy any security. The 
investment strategies or the securities 
may not be suitable for you. Any and all 
opinions expressed in this publication 
are subject to change without notice.

 • Options transactions involve com-
plex tax considerations that should be 
carefully reviewed prior to entering 
into any transaction.

• The risk of loss in trading securities, 
options, futures, and forex can be sub-
stantial. Clients must consider all rel-
evant risk factors, including their own 
personal financial situations, before 
trading. Options involve risk and are 
not suitable for all investors. See the 
Options Disclosure Document: Char-
acteristics and Risks of Standardized 
Options. A copy accompanies this 
magazine if you have not previously 
received one. Additional copies can be 
obtained at tdameritrade.com or by 
contacting us. 

• Trading foreign exchange on margin 
carries a high level of risk, as well as its 
own unique risk factors. Before consid-
ering trading this product, please read 
the Forex Risk Disclosure, available at 
http://www.nfa.futures.org/NFA-
investor-information/publication-
library/forex.pdf. 

• Supporting documentation for any 
claims, comparisons, statistics, or 
other technical data will be supplied 
upon request.

• A forex dealer can be compensated 
via commission and/or spread on forex 
trades. TD Ameritrade is subsequently 
compensated by the forex dealer.

• Futures and forex accounts are not 
protected by the Securities Investor 
Protection Corporation (SIPC).

• Futures, futures options, and  
forex trading services are provided by  
TD Ameritrade Futures & Forex LLC. 
Trading privileges are subject to review 
and approval. Not all clients will qual-
ify. Forex accounts are not available to 
residents of Ohio or Arizona.

TD Ameritrade, Inc. member  
SIPC/FINRA and a subsidiary of  
The Charles Schwab Corporation. 

TD Ameritrade is a trademark jointly 
owned by TD Ameritrade IP Company, 
Inc. and The Toronto-Dominion Bank. 
© 2021 Charles Schwab & Co., Inc.  
All rights reserved. Member SIPC. 
Product and company names men-
tioned herein may be trademarks  
and/or registered trademarks of their 
respective companies.

Transaction costs are important fac-
tors and should be considered when 
evaluating any options trade. For 
simplicity, the examples in these arti-
cles do not include transaction costs. At 
TD Ameritrade, online options orders 
are $0.65 per contract. Orders placed 
by other means will have higher trans-
action costs.
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• THERE’S AN OLD SAYING IN TRADER  
circles: Don’t approach a short-term trade 
with a long-term view—and vice versa. 
The idea behind it: In the short term, pric-
es move on today’s dynamics—economic 
cycle, momentum, and so forth—and in the 
long term on fundamental shifts.  

But if you go out on a long enough 
timeline, the short term becomes the long 
term. And for a trader, it’s important to 
identify those inflection points. Why? If 
you’re trading on momentum, sometimes 
the long-term trend can act as a tailwind if 
it’s in sync with your short-term momen-
tum trade.

A LOOK AT THE ENERGY MARKET
On the surface, last year might have looked 
like an inflection point. Consider:

• The crude oil market nearly collapsed at 
one point during the pandemic.
• Companies that make electric vehicles 
(and the batteries that power them) attract-
ed massive capital flows.
• Alternative energy indices such as the 
S&P Global Clean Energy Index (SPGT-
CLEN) continued to forge ahead to new 
highs, while Energy was the cellar dweller.

Some may call last year “the year of the 
disruptor.” Anything that looked to upend the 

old order attracted attention—and capital. 
And now, with a new administration—one 
that will likely take a friendlier view of alter-
native energy—it could mean headwinds for 
oil drilling and exploration.

But there’s a difference between intentions 
and realities, and again, the short and long 
term. In the short term, the focus is still on 
controlling a pandemic, distributing a vac-
cine, and keeping the economy afloat in the 
process. Long-term energy trends will likely 
take a back seat—and stay there for a while.      

As of this year, there are roughly 300 
million cars registered in the United States, 
and all but about 1% of them have internal 

P H O T O G R A P H :  D A N  S A E L I N G E R
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combustion engines. 
Plus, even those 
electric vehicles run 
predominantly on 
fossil fuels—about 
two-thirds of electric 
power in the United 
States is derived 
from the stuff pulled 
from the ground.  

Meanwhile, CME 
Crude Oil futures 
(/CL) have been 
relatively stable in 
the mid $40s per 
barrel since summer 

2020 and even broke above the $50 level in 
January 2021. The Energy sector had some 
upward momentum off the lows as well. So, 
you don’t want to ignore the short term since 
it could mean missed opportunities.

If an investor trades oil on the technicals, 
there’s nothing wrong with the status quo 
game plan. Watch the supply and demand 
dance, levels of support and resistance, and 
the occasional breakout—and trade the 
market as you see it.    

For a longer-term view, look to an index 
such as the S&P 500 Energy Select Sector 
Index (IXE) and subindices such as the S&P 
Oil & Gas Exploration & Production Index 
($SPSIOP). What’s the overall trend of stock 
prices of oil and gas companies? Are there 
new regulations in the pipeline, and if so, how 
far into the future have they been deferred?

Also, take a look at the term structure of  
/CL. You can see the futures curve going out 
10 years, which could give you an idea of how 
the market is pricing in the long term. 

While there may be a long-term shift 
toward alternative energy, in the short term 
there may be opportunity in the oil  
complex.   —Words by  DOUG ASHBURN

Doug Ashburn is not a representative of  
TD Ameritrade. The material, views, and opinions 
expressed in this article are solely those of the 
author and may not be reflective of those held by 
TD Ameritrade, Inc. 

For more on the risks of trading and trading 
futures, see page 35, #1&3.

What If ... ?

It’s easy to get attached to certain features on our phones, cars, or 
gaming software. The downside—we become oblivious to features 
we never use. We may not need them. But what if they made our 
lives simpler or gave us a different perspective? After all, they were 
invented for a reason.

Think of your “go-to” features on the thinkorswim® platform 
from TD Ameritrade. Maybe you use the Option Chain, Today’s 
Options Statistics, and Positions and Simulated Trades. Why not 
go beyond your comfort zone and try other tools on the Analyze tab 
that could take your options analysis up a notch? Three to consider: 
Price Slices, thinkBack, and OnDemand.

 Price Slices
Ever seen this below the Option Chain? Know what it does? In a 
nutshell, it answers the question, “How much is your trade likely to 
make or lose if the underlying moves by some amount?” In effect, it 
helps you run through different “what-if” scenarios.  

FIGURE 1: SLICE AND DICE. On thinkorswim, the Price Slices tool can be found below the Option Chain.   
Source: thinkorswim from TD Ameritrade. For illustrative purposes only.  

THINKTANK

There are many ways a trade can  
play out. How do you prepare yourself?  
You might consider Price Slices,  
thinkBack, and OnDemand.

IN THE MONEY

–1–
Expand

Price Slices

–2–
Set

slices–3–
Analyze 
options, 

greeks, P&L, 
BP effect

–4–
Send slices

to charts

IN
FO

 B
OXTOOL TIP

VIEWING 
TERM 
STRUCTURE
On the  
thinkorswim® 
platform from  
TD Ameritrade, 
go to Charts > 
Product Depth, 
and under the 
Curves subtab, 
select All Series.
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FIGURE 3: TICK BY TICK. Rewind and binge-watch options trades as they played out with the OnDemand feature 
(found under the  Analyze tab) on thinkorswim. Source: thinkorswim from TD Ameritrade. For illustrative purposes only.  
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You can create as many price slices as you 
want and set them based on different vari-
ables (see Figure 1).

 � –  Enter symbol and expand Price Slices.
 2 –  Select the Price Slices menu and  

set slices based on percentages,  
dollar value, and standard deviations,  
among others. 

3 –  Analyze the options greeks, profit and 
loss (P&L) at the open, P&L for the 
day, and buying power (BP) effect. 

4 –    Send these slices to the chart of any 
stock you’re analyzing. 

How do you select the slices? You could 
go back in time and identify significant 
price levels. Although the past isn’t a pre-

dictor of future price movement, it could 
act as a guide to help you prepare for differ-
ent market scenarios.

thinkBack
Along the top of the Analyze tab, you’ll  
find the thinkBack subtab. At first glance  
it looks similar to the Add Simulated 
Trades subtab. The big difference: You’ll 
see end-of-day options going back 10 years 
(see Figure 2). 

 � –  Enter a symbol. From the calendar on 
the upper right, select the date you 
want to see. 

 2 –  Expand any expiration to see the 
strike prices, especially those that line 
up with the price slices.

–1–
Select a 

date from 
calendar

–2–
Expand any

options
expiration

–1–
Select 

OnDemand
and date

–2–
Select Bid 

or Ask to buy 
or sell

–3–
Fast- 

forward or 
rewind

FIGURE 2: GO BACK IN TIME. The thinkBack feature is a subtab under the Analyze tab on thinkorswim.   
Source: thinkorswim from TD Ameritrade. For illustrative purposes only.  

Use thinkBack to test different options 
strategies and imagine what you would’ve 
done if certain scenarios played out.

OnDemand 
This is another tool that lets you look back-
ward. OnDemand is different in that it can 
replay all data on any day from December 
7, 2009, to the present day. You can go back 
and watch any stock, index, future, or op-
tion, tick by tick, as it happened. And you 
can trade right along with it, using virtual 
money. It gives you an account with a vir-
tual balance of $100,000 so you can enter 
simulated trades based on the replayed 
prices and see the P&L change. 

The OnDemand icon is found at the top 
right of every thinkorswim tab (see Figure 3). 

 � –  Enter a symbol, then select the icon 
and go back to any date. 

 2 –  From the Option Chain, select a bid 
or ask to buy, and sell just as if you 
were trading in real time.

3 –  Fast-forward or rewind the data. 
 
When you’re done, select OnDemand 

again to go back to your live trading account.
Give these tools a try. They could be a 

conversation starter when you next chat 
about trading options.

Results presented in analytical trading tools such 
as Price Slices, thinkBack, and OnDemand are 
theoretical. Successful virtual trading during one 
time period does not guarantee successful invest-
ing of actual funds during a later time period as 
market conditions change continuously.
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We often hear about traders 
selling options. But why (or 
when) might a trader buy 
options?
It’s true that selling options has 
many benefits, but there are 
times when it may make sense  
to buy options.  

Traders might use long calls 
and puts to make more efficient 
use of a portfolio’s capital (versus 
buying stock outright) to attempt 

to take advantage of a directional 
move in the underlying. If the 
stock makes a strong move in the 
direction you’re hoping for, its 
underlying options are likely to 
make a significantly larger per-
centage move. 

For example, a 5% rise in a 
stock may mean a 50% increase 
in the price of a call option. A 5% 
drop in the underlying may mean 
a 50% increase in a put option. 

The lower cost of the options 
versus buying an equivalent 
amount of the underlying can 
translate to capital efficiency. For 
example, this could be a benefit 
when long puts are used to help 
protect a stock or an entire port-
folio against a down move in the 
underlying stock. 

Long options can also benefit 
from spikes in implied volatility 
(IV). Long options are vega pos-
itive. This may be advantageous 
in the case of long puts, because 
when there’s a strong drop in the 
underlying, IV will likely rise. The 
long put trader can benefit from 
favorable delta and vega effects. 
Bottom line: The sensitivity to 
volatility changes might mean you 
can use long options when you 
anticipate large volatility moves. 

But these benefits also have 
another side to them: IV can 
drop and make it even harder to 
make money. 

Then there’s theta lingering 
in the background that can work 
against you. But you may be 
able to minimize theta damage. 
Theta is generally higher closer 
to the expiration date and when 
it’s closer to being at the money. 
So you could buy options that 
are further out until expiration, 
shorten the holding period of the 
contract, and buy contracts that 
are further in the money (ITM).

Is there a way to figure  
out how much impact a 
change in the underlying 
stock price may have on  
the options price?
The Theo Price tool on the 
thinkorswim® platform from  
TD Ameritrade could help. You 

can find it in the 
Option Chain 
under the Trade 
tab. Select Theo 
Price, Mark from 
the Layout menu, 
then select Theo 

Price. This opens a menu where 
you can make theoretical adjust-
ments to the stock price. In the 
Option Chain you can see what 
the theoretical price of the option 
might be. 

By changing strike prices and 
expiration dates, you can help 
control how much risk to take 
when buying options. Generally, 
the more ITM a contract is and 
the further out until expiration, 
the more expensive it’ll likely be. 

Options buying can be an  
important part of your tool 
chest. In general, these tips can 
help you navigate the world of 
long options:

• Have rules for entries and 
exits. Plan ahead and don’t let 
emotions rule your trading.

• Remember that long op-
tions are speculative. Because 
of the effects of theta, you’re 
fighting against time and need the 
underlying stock to move in your 
direction within a certain period 
of time. If the underlying stock 
price moves opposite of your 
expectations, the long options po-
sition will likely expire worthless, 
resulting in the loss of your entire 
investment in that option.

• Education is key. Options 
trading in general, and long 
options trading in particular, is 
subject to significant risk and 
isn't appropriate for everyone. 
Know what you’re doing before 
you begin trading options.

Making Exceptions: 
Buying Options  
Instead of Selling Them
Sometimes trying different strategies  
can open up new perspectives. We asked  
Brent Moors, education coach at  
TD Ameritrade, to shed some light.

TRADER 
GLOSSARY
TURN TO 
PAGE 33

P H O T O G R A P H :  D A N  S A E L I N G E R
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• How often have you tried to get your chart 
crosshair to point precisely to the level you 
want, yet failed? Blame it on the notification 
that popped up and made your hand slip. 
Well, that’s no longer an obstacle thanks to 
the Crosshair Snapping tool. It allows you to 
“snap” the crosshair to a desired price.

(Note that this feature works only when the 
cursor type setting below the chart on the bot-
tom right is set to cross, horizontal, or vertical.  
It won’t work if “none” is selected.)

Here’s how it works. Under the Charting 
tab on thinkorswim® from TD Ameritrade: 

 � –  Select the settings icon at top left (the 
gear wheel).

 2 – Select Appearance.
 3 –  In the Snap Crosshairs drop-down 

menu under Common, select None, 
Open, High, Low, Close, or OHLC.

The crosshair will automatically snap to 
the applicable price for the given aggregation 
period. It doesn’t matter if the chart is a bar, 
candle, line, or any other type. 

How can this feature be applied to trad-
ing? If you want to set a stop order just below 

the day’s low price of the day, the Crosshair 
Snapping tool could quickly identify that level.

Identifying price levels is important for 
spotting support or resistance areas, pivot 
points, retracement levels, and so on. But to 
precisely place the cursor on a specific price 
level can be difficult—shaky hands, an over- 
responsive mouse, or clumsy finger errors can 
cause the cursor to slip. The Crosshair Snap-
ping tool expedites the process and requires 
less precision in cursor placement. It identifies 
these levels quickly. 

For example, if you select High, the tool 
will snap to all those data points (see Figure 
1). There’s no need to make sure you have a 
steady hand on a specific price bar while si-
multaneously reviewing price data across the 
top of the chart to identify all data points.  

Option traders can benefit from the tool as 
well, especially to identify potential strike pric-
es for options contracts. If, for example, a put 
seller wants to sell a contract below a recent 
low price of a stock price bounce, the Crosshair 
Snapping feature can quickly identify that low. 

SO NEXT TIME YOU’RE TRYING TO IDENTIFY 
price-bar data, save yourself the frustration 
and set up the Crosshair Snapping feature on 
your chart settings. When you see the precise 
data displayed on the price axis, think about 
where to place your entries, exits, and strike 
prices. It can shave a few seconds off your 
chart analysis. May not seem like much. Yet, a 
few seconds can add up, especially if you look 
at several charts in a trading day. 
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When you trade futures, you often wind up with a lot of questions. That’s why, at TD Ameritrade, we have 
on-demand education, futures specialists ready to talk day and night, and an intuitive trading platform.  
So whatever the question, you’ll have all the answers you need. 

Learn more at tdameritrade.com/tradefutures

How is futures margin different 
from equities margin?

Futures trading is speculative, and is not suitable for all investors. Futures trading services provided by TD Ameritrade Futures and Forex LLC. Trading 
privileges subject to review and approval. Not all clients will qualify. Futures accounts are not protected by SIPC. All investments involve risk, 
including  risk of loss. © 2021 Charles Schwab & Co., Inc. All rights reserved. Member SIPC.
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TRADE WINDS

Snap Your Price
Identify the open, high, low, and close instantly 
with the Crosshair Snapping tool.

BRENT MOORS
EDUCATION COACH
TD Ameritrade 

For more on the risks of trading and trading options, 
see page 35, #1&2.

FIGURE 1: CROSSHAIR SNAPPING TOOL IN ACTION. 
When you select any price bar, the crosshair snaps to 
your desired data point. On this chart, the crosshair 
snaps to the high of the bar. 
Source: thinkorswim from TD Ameritrade. For illustrative purposes only.  

Snaps 
to the 
high

P H O T O G R A P H :  D A N  S A E L I N G E R
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When you trade futures, you often wind up with a lot of questions. That’s why, at TD Ameritrade, we have 
on-demand education, futures specialists ready to talk day and night, and an intuitive trading platform.  
So whatever the question, you’ll have all the answers you need. 

Learn more at tdameritrade.com/tradefutures

How is futures margin different 
from equities margin?

Futures trading is speculative, and is not suitable for all investors. Futures trading services provided by TD Ameritrade Futures and Forex LLC. Trading 
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PHOTOGRAPHS BY 
DAN SAELINGER

B I G  I D E A : 

WHETHER YOU FIRST STARTED CHARTING STOCKS ON 
PAPER, SOFTWARE, OR A SMARTPHONE, YOU’RE 

LIKELY TO MAKE THE SAME MISTAKES. HERE’S HOW TO 
AVOID FALLING INTO TYPICAL CHARTING TRAPS. 

WORDS BY JAYANTHI GOPALAKRISHNAN

TA K E  AWAY: 
How to avoid the 
more common
charting errors.E A SY

S K I L L

L E V E L

B I G G E ST  C H A RT I N G 
M I STA K E S  YO U ’ R E 

P R O B A B LY  M A K I N G 

T H E
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ment level, you might say price is at the 78.6% 
level. Why risk sounding like you may not 
know charts as well as you think you do?

Another common chart error is drawing 
trendlines on the wrong end of the price 
bars. The common rule is in an uptrend, 
draw trendlines that touch the lows, and in a 
downtrend, draw trendlines that touch the 
highs. It can be hard to remember because 
the natural tendency is to think highs when 
you think of uptrends and lows when you 
think of downtrends. In a sense, it’s counter-
intuitive. But do it for a while and it’ll become 
second nature.

ANALYSIS PARALYSIS: NOT 
KNOWING WHAT TO DO

Sure, there are tons of indicators, drawing 
tools, and chart patterns to choose from. 
You can get dizzy trying to figure out which 
ones to use. Sometimes, you’d rather pro-
crastinate, which means you miss out on 
promising trades. Other times, you’re too 
afraid to trade and would rather not make 
any decisions. Or perhaps you suffer from 
“analysis paralysis” and don’t want to hit a 
buy or sell button. Overcoming these feel-
ings can be tough. But if you’re determined 
to conquer these behaviors, consider imple-
menting a methodical approach to tackling 
the markets.

The good news? There are tons of ways to 
do this. You could set up a system where you 
scan for stocks that meet specific criteria, an-
alyze those charts, then narrow your choices.   

To err is human. 
And to do so in your trading platform doesn’t 
take much. Entering an incorrect stock 
symbol, adding an extra zero to the order 
quantity, or interpreting a chart incorrect-
ly—these are all ingredients for impressive 
trading mistakes. 

All errors aren’t created equal; some may 
have easier fixes than others. Technical ana-
lysts have a unique challenge because there’s 
no right or wrong way to analyze charts and 
multiple ways to interpret them, leaving the 
field wide open. 

CHARTING TRAPS TO AVOID 
A momentum trader may want to see a 
strong breakout before jumping into a trade. 
A trend trader, on the other hand, might 
look for a breakout confirmation. And a 
short-term trader may only be interested in 
volume thrust. 

When looking at a price chart, the desire to 
jump into a trade could surge at the first sign 
of things going your way. If luck’s on your 
side, the trade could work out. But fake outs 
happen. How many times have you suc-
cumbed to enter a trade only to find out later 
that you didn’t read the chart correctly?

Although there’s no right or wrong way to 
parse a chart, consider five charting mistakes 
that deserve a place in the Charting Bloopers 
Hall of Fame.

YIKES! YOU’VE GOT 
IT BACKWARD

Say you’ve fired up your thinkorswim® plat-
form from TD Ameritrade and are looking at 
a stock chart. You see a clear low point, and a 
few months later, a clear high point. You want 
to figure out where to enter a trade, so you 
add Fibonacci retracement levels to help see 
the support and resistance levels. You bring 
up your drawing tools, select the % symbol, 
and drag the tool from the high point to the 
low point. Oops! There’s a problem. The high 
point is to the right of the low point. You’re 
supposed to draw Fibonacci retracements 
from left to right, and in this case, that would 
be from low to high (see Figure 1).

It may not be the worst thing in the world. 
The retracement levels would be the same, 
but the percentages would be reversed. So 
instead of saying price is at the 23.6% retrace-

Or, maybe you’re a momentum trader who 
prefers to trade chart patterns, and you’d 
rather look for chart patterns that reflect 
crowd behavior. This might involve setting 
up a trading plan that focuses on identifying 
breakouts from consolidation, continuation, 
or reversal patterns. Above all, find a few 
approaches that work for you.

INDICATOR PALOOZA: 
RESIST THE URGE

When you look at a chart, do you want it to 
tell you what you want to hear? If so, you run 
the risk of placing too many indicators or 
patterns on a chart. And if you have too many 
indicators, you may end up misreading the 
indicators or chart patterns. 

One solution could be to create a set of 
core indicators that look at different types of 
price action. For example, you could break 
down the indicators into four categories: 
price action, trend following, momentum, 
and an overall indicator (see sidebar: “Too 
Hot, Too Cold. What’s Just Right?”). 

FIGURE 1: FIB RETRACEMENTS GO FROM LEFT TO RIGHT. On the thinkorswim platform, select Drawings > 
Drawing Tools > % (Fibonacci Retracements). Place the tool at the low point and drag it to the high. This  
displays the different retracement levels you see on the chart (yellow horizontal lines). Source: thinkorswim from  

TD Ameritrade. For illustrative purposes only. 
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Want to set up a trading system? 
Check out this approach: “Technical 
Analysis and Charting: How to Build 
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Looking for specific chart patterns? 
Learn about momentum patterns 
here: http://bit.ly/TT-MomoTrd
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DON’T GET SKIMPY:  
BE BALANCED 

Maybe minimalism is your schtick, but too 
few indicators could generate false signals. 
Because there’s no certainty in signals gen-
erated by technical indicators, it’s important 
to have just enough indicators to get con-
firmation signals. For example, if you base 
trading decisions on moving averages, which 
may have worked well during an extended 
bull market, there may come a time when the 
indicator may no longer work well. The trend 
could slow down, pull back, or even reverse. 

Moving averages are lagging indicators; by 
the time you get a trading signal, the market 
may have already changed direction. Remem-
ber that markets are dynamic, so it’s not a 
good idea to get comfortable using one or two 
indicators. A good mix is likely to alert you of a 
change earlier rather than later.

VIVA LA VOLUME!  
DON’T IGNORE IT

Price movement without volume can be mean-
ingless. When momentum is in vogue, you’re 
likely considering stocks that have enough  
volume to move them up or down. Volume 
bars are a popular way to see how much 
trading is taking place. But there are some 
volume-related indicators such as on-balance 
volume or accumulation/distribution you 
could also consider. Then ask yourself these 
questions: When price is moving up or down, 
is volume also going up? When a price bar 
breaks out, is it accompanied by high volume? 
Do you notice any unusual volume spikes? 

A GOOD FIX FOR THESE COMMON CHARTING 
mistakes is mindful awareness. As you know, 
markets change, sometimes quickly, which 
might make you act irrationally. Yet, being 
aware of errors could help you approach  
the markets with a calmer, more logical 
mind—one that’s ultimately wired to make 
fewer mistakes.

TOO HOT, TOO COLD. 
WHAT’S JUST RIGHT?
No two chartists will look at charts the same 
way. What you put on a chart depends on 
your trading style. The thinkorswim platform 
has more than 300 indicators to choose 
from. To browse them, select Studies > Add 
Study. Browse different categories and try 
out different indicators. You may find some 
useful ones you never knew existed. Here’s 
an example of how you could organize 
indicators into different categories:  

Price action–Candlestick bars / Support  
and resistance levels / Fibonacci retracement 
levels 
Trend following–Trendlines / Moving 
averages / Moving average convergence 
divergence (MACD)
Momentum–Stochastic / Relative Strength 
Index (RSI)  
Overall market indicator–Bollinger Bands® 

On the candlestick chart in Figure 2, Fibonacci 
retracement levels (drawn from a top [left] 
to a low [right]), volume, and Bollinger Bands 
are overlaid on the price bars. The RSI, which 
measures momentum, and MACD, a trend- 
following indicator, are added as subcharts. 

A FEW OBSERVATIONS:
1. After hitting the low in mid-March, price 
started moving up toward the middle 
Bollinger Band. At the same time, price 
crossed above the 23.6% and 38.2% Fib 
retracement levels (and got pretty close to 

the 50% level). Momentum started moving 
up, as seen in the upward-trending RSI. The 
MACD crossover also indicated the trend 
reversed from down to up. Volume was 
relatively high during this time.  
2. A short-term modest pullback followed as 
prices continued moving along the middle 
Bollinger Band and prices moved back toward 
the 23.6% Fib retracement level. The RSI 
looked to be trending lower, but MACD con-
tinued moving up. Volume decreased toward 
average levels.    
3. We then see a reversal, with prices moving 
back toward the upper Bollinger Band and 
traveling along that upper band for a couple 
of weeks. Prices moved up to the 61.8% Fib 
retracement level, and RSI and MACD were 
trending up. Volume was at average levels. 
4. In late April, the trend slowed down, 
with prices pulling back toward the middle 
Bollinger Band and 50% Fib retracement 
level. RSI and MACD were relatively flat, and 
volume was lower with some unusual spikes. 
The stock was stuck in a trading range.
5. It wasn’t until early June that we saw 
some activity to the downside. Price moved 
back toward the lower Bollinger Band, which 
coincided with the 50% Fib retracement 
level. Volume spiked on the down move, RSI 
saw a significant drop, and MACD was slowly 
trending lower. 

When all indicators suggest the same action, 
this might help you make more confident 
trading decisions.   

FIGURE 2:  NOT TOO FEW, NOT TOO MANY. On the thinkorswim platform, select the Charts tab and 
enter a symbol to bring up a chart. Then add your core indicators or studies from the Studies subtab. 
Choose indicators from different categories. Here you see Fibonacci Retracement levels, Bollinger 
Bands, volume, RSI, and MACD. Source: thinkorswim from TD Ameritrade. For illustrative purposes only. 
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Not surprisingly, this is often how you’ll 
feel when staring at a profitable trade and 
wondering whether to keep your line in 
the water to potentially eke out some more 
gains or cut bait and move on. Unfortunate-
ly, gut trading isn’t typically a great strategy 
in the long run. 

In a sense, deciding when to get in to a 
trade is easy. Sure, there’s lots of analysis to 
be done to decide which trade to take, but 
for most traders, the desire to “make mon-
ey” can be pretty compelling on its own. 
Yet, when it comes to deciding when to exit 
a winning trade, the desire to make “more 
money” when things are going swimmingly 
can be a bit too alluring and often has con-
sequential effects. 

The next time you find yourself in a 
winning trade and think you can squeeze 
a little more, consider a few strategies to 
hedge your profits and leave a fixed amount 
of money (or rocks) on the table. 

PLAN AHEAD
Because buying options is naturally more 
complex than buying stock—due to price, 
time, and volatility—exiting trades can 
be equally complex if you feel there’s still 
room to run. Essentially, it comes down to 
three choices: 

 1 – Do nothing
2 – Exit completely
3 – Realize partial profits and/or modify  
the trade
Using a long call position, let’s break ’em 

down. See Figure 1 for the risk graph of a 
long call.

When to Do Nothing.
If you buy a call with a profit target and/or 
time frame in mind, it might make sense to 
simply let your expected scenario play out 
until either your profit target or time frame 
are hit. For example, say you buy a call option 

expecting the underlying security to advance 
10% in the next two months. One week later, 
the underlying is up 4% and you have a de-
cent profit on the call option. If your goal is to 
maximize the profitability associated with a 
10% move within two months, it may be time 
to steel your spine and simply let the trade 
ride to achieve your original goal. 

When to Exit Completely. 
If you entered a long call based on a specific 
profit target or profit range for either the op-
tions position or the underlying security, and 
you hit either target, then it makes perfect 
sense to cash out and exit, sticking to the plan 
you already laid out. But there’s a third option.

When to Take Partial Profits 
and/or Modify. 
When your conviction is that the underly-
ing trend is strong and may continue, taking 
partial profits and/or modifying your posi-
tion could allow you to improve the overall 
reward-to-risk trade-off. More specifically, 

modifications are often done to lock in 
profit and/or mitigate risk, while retaining 
the opportunity for more gains.

What’s important to note is that when 
you modify a trade, you’re essentially 
putting on a new trade. Therefore, before 
doing so, make sure you’re doing the same 
due diligence on the “new” trade that you 
did getting into it in the first place. Are the 
same factors still in play? If not, you may 
want to think about getting out entirely and 
moving on to a new opportunity.

HOW TO MODIFY LONG CALLS
Let’s jump out of theory and into a mock 
trade. Suppose stock XYZ is trading at 
$50 per share, and you buy 10 call options 
on XYZ at the $50 strike for $3 (totaling 
$3,000 in capital). 

 From there, XYZ rallies to $56 per share, 
and in the process, the 50-strike calls climb 
to $7. You’re now sitting on a $4,000 profit 
(minus any commissions and contract fees). 
If you think XYZ will continue to rally 
strongly, you can:

1 – Do nothing, hoping the stock keeps 
climbing as well as your call. 
2 – Cash out and sell the 10 calls, cash in 
on the $4,000 profit, and move on.
3 – Realize some profit and/or modify the 
position. 

However, there are two considerations 
to keep in mind when deciding to modify a 
trade: not wanting to walk away from the 
stock completely and not wanting to risk 
giving back the entire windfall profit if the 
rally fizzles and XYZ reverses. 

What are some possibilities? 

Sell Half  
 Once an option doubles in value, you can 
sell half of your original position and lock in 
a break-even trade at worst. Let’s consider 
this possibility. In our example, say you:

• Bought 10 @ $3
• Then sold 5 @ $7

NUMBER  1 

Call at expiry

BREAKEVEN

Profit

Loss

Stock Price

FIGURE 1: LONG CALL. For illustrative purposes only.  

There’s a great scene in the movie  
All the Money in the World when Fletcher 
Chase asks J. Paul Getty how much  
money it’d take to make him feel secure. 
To which Getty replies, “More.” 

Call at onset
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By doing so you’ve pro-
tected your original invest-
ment and banked $500, 
while hanging onto five of 
the calls (the remaining 
$3,500 in profit). If the rally 
continues, and the calls con-

tinue to increase, so does your profit. 
On the other hand, XYZ could gap down 

below 50 overnight and render the five 
remaining calls worthless. In this scenario, 
you still lock in a $500 profit. Gaps aside, 
however, much of the time you can set a 
stop underneath your options price (say, 
50% below current price), which could still 
give you a nice gain overall, depending on 
what price you actually exit at when your 
stop order triggers. 

Sell Half and Spread the Rest
Using the same trade, you think XYZ could 
continue to rally up to $60 per share. You 
could again sell half of your calls at $7, take 
the original risk off the table, bank the 
$500, and turn the remaining calls into 
a vertical spread by selling higher-strike 
calls on those that remain (see Figure 2). If 
the 60-strike calls are going for, say, $1.50, 
that’s an additional $750 you can bank now 
(5 x $150) without adding more risk to the 
trade. You’ve now locked in a total profit  
of $1,250, even if the stock falls to zero at 
this point.

Now, suppose XYZ continues to rally 
and closes at $60 on expiration day.  
You end up with a net profit of $6,250  
as follows:

• Ten 50-strike price calls bought  
@ $3 each
• Long five 50-strike price calls sold  
@ $7 each (profit of +$2,000)
• Long five 50-strike price calls worth 
$10 each at expiration (profit of +$3,500)
• Short five 60-strike price calls expire 
worthless (profit of +$750)

But if XYZ closes at $50 per share at 
expiration, as mentioned, you still end up 
with a net profit of $1,250 as follows:

• Ten 50-strike price calls bought  
@ $3 each
• Long five 50-strike price calls sold  
@ $7 each (profit of +$2,000)
• Long five 50-strike price calls expire 
worthless (loss of -$1,500)
• Short five 60-strike price calls expire 
worthless (profit of +$750)

With XYZ shares above $60, the profit is 
capped at +$6,250. For each $1 increment 
below $60 per share to $50 per share, the 
profit declines by $500. With XYZ shares 
at $50 or below, the worst-case senario is a 
profit of +$1,250.

Roll Up (to a Higher Strike Price)
Let’s go back to something we touched on 
earlier. You’re sitting on a $4,000 unreal-
ized profit. You don’t want to risk giving 
it all back—but you believe there’s a good 
chance the rally in the underlying will con-

tinue. There’s a super simple modification 
you can make called “rolling up.” To roll up 
simply means to sell calls you now hold and 
use some or all of the proceeds to buy low-
er-priced calls at a higher strike price.

The 50-strike calls you bought for $3 are 
now trading at $7. During this time, the un-
derlying stock has risen from $50 to $56 per 
share. A simple roll up might look like:

• Sell 10 50-strike price calls @ $7
• Buy eight 55-strike price calls @ $3.75

Let’s consider the net effect of this simple 
adjustment: 

• You bank a $4,000 profit in the 50-strike 
price calls.
• You spend $3,000 to buy eight 55-strike 
price calls ($3.75 x 8 calls x 100 shares).

The worst-case scenario—if XYZ stays 
below $55 through options expiration, you’re 
left with a $1,000 profit from the sale of the 
50-strike calls. However, if the stock keeps 
rallying, you could have unlimited potential, 
while your original risk and a decent profit 
are now “off the table.”  

THE GOOD NEWS IS THAT OPTION 
traders have many possible choices. The 
bad news is that too many choices can lead 
to confusion and indecisiveness, and at 
times, frustration. This is why it’s critically 
important that you have a plan when you 
enter each trade regarding which criteria 
would trigger you to exit the trade com-
pletely and under what circumstances an 
adjustment to the original trade could lead 
to an improved reward-to-risk trade-off.

NUMBER  2

NUMBER  3

FIGURE 2: LONG CALL VERTICAL. For illustrative purposes only.
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delta. So if a call option has a 0.50 delta, a $1 
rise in stock XYZ would theoretically raise 
its value by $0.50. But here’s the kicker—as 
XYZ rallies, so does its delta by an amount 
known as its gamma. In other words, gam-
ma can magnify the effects of the under-
lying stock movement on the price of an 
option (see Table 1).  

As XYZ moves from $60 to $61, the 
60-strike call’s TV increases by $0.55, 
which is a bit more than its 0.50 delta would 
suggest. It may help to consider delta over a 
range instead of a single point. So, from $60 
to $61 in the underlying, the average delta is 
(0.60 - 0.50)/2 = 0.55.  

Because of gamma, as XYZ rallies, the 
call’s TV rises at a faster rate until it becomes 
a deep in-the-money (ITM) call, with a delta 
approaching 1.0 until it moves virtually 1:1 
with the stock price. And if the stock price 
drops, the delta decreases as well. Although 
the call option drops in value as the strike 
moves further out of the money (OTM), it 
does so at a slower and slower rate until, at 
some point, its delta is virtually zero.

The same holds true for put options. If 
you’re long an ATM put and the stock goes 
down, the TV of the option increases at an 
increasing rate. If the stock goes up, the 
put’s TV decreases at a decreasing rate. 
That’s the power of gamma.

But gamma isn’t free. To be long gamma 
is to be long options, which means nega-
tive theta. At any snapshot in time, gamma 
augments delta and thus TV. But with each 
passing moment, theta is pushing TV the 
other way. With options, there’s always a 
trade-off.

                                 ind yourself trading the same 
strategies over and over? Sometimes mixing 
things up and learning about other strategies 
doesn’t hurt. Take straddles for example. 
There are times when an option looks like a 
buy—not from a directional standpoint but in 
terms of volatility (vol). The stock may have 
been fluctuating, and you think it’s priced 
cheap relative to its historical vol and daily 
price moves. So, you might want to get long 
vega by buying an at-the-money (ATM) 
straddle. You’d choose the ATM strike be-
cause it’s the point of maximum vega, plus it’s 
delta-neutral—the 0.50 delta from the ATM 
call is offset by the put’s -0.50 delta.   

Yet, buying and holding a straddle is 
risky. Not only do you have the vega risk—
just because vol is low doesn’t mean it can’t 
go even lower—but you’ve also got time 
working against you in the form of theta, 
i.e., time decay.

The theoretical value (TV) of an option is 
based in part on how much the price of the 
underlying stock is likely to move between 
now and expiration. The less time left until 
expiration—theoretically, anyway—the less 
opportunity for movement. So all things 
being equal, the price of a long option loses 
value with each tick of the clock.

When you sell an option, theta acts as a 
strategy tailwind. But with long options, it’s 
the opposite. So for that long ATM straddle, 
the negative-theta meter starts running once 
you place the trade.     

But there’s a positive side to negative theta: 
gamma. And if you’re long an ATM straddle 
in anticipation of a vol spike, gamma might 
be the key to help offset a theta drag while 
you wait. 

THE GAMMA/THETA TRADE-OFF
When stock prices move, options prices also 
move by an amount roughly equivalent to the 

NOT JUST FOR THE BIG PLAYERS  
ANYMORE
Until recently, gamma scalping wasn’t a pop-
ular strategy among smaller retail traders. To 
consistently get that “hedge-able” quantity 
of shares for your gamma scalp, you might’ve 
had to take on too large of a position size, or 
widen your entry and exit points. Otherwise, 
commission costs would’ve likely eaten into 
the net profit per scalp.

TRADING THE GAMMA
Going back to Table 1, suppose you bought 
five of the 60-strike straddles for $4 each. 

Consider this scenario: Suppose that af-
ter you bought the straddles, XYZ dropped 
to $59, but then rallied back to $60 by the 
end of the day. The TV would’ve risen from 
$4 to $4.10 and then likely fallen back to 
$4. But now that it’s the end of the day, all 

If you own shares of a stock, you don’t 
need to buy the straddle. Instead, you 
can get the same exposure by buying 
two ATM puts for every 100 shares. It’s 
called a synthetic straddle. If the stock 
rallies, you may want to sell a portion of 
your long shares rather than go short. 
Short selling can be a messy business, 
and not all accounts qualify.   

F

DISCOVER SYNTHETIC 
STRADDLES

TABLE 1: THEORETICAL GREEKS OF A DYNAMIC HEDGE.  Sample data for illustrative purposes only.
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things being equal, that negative theta kicks 
in, dropping TV by $0.06 per option, or 
$60. (Remember, it’s five calls and five puts 
times the multiplier of 100.)

What if you’d bought 100 shares of XYZ 
when it was down at $59? After all, it wasn’t 
just the TV that changed when the stock 
broke; the deltas changed as well—the call 
from 0.50 to 0.40 and the put from 0.50 to  
0.60. Combine them, and that’s a 0.20 delta 
times the five straddles, or 1.00 deltas. 

You could’ve bought 100 shares of XYZ to 
maintain a delta-neutral position. And when 
XYZ moved back to $60, you could’ve sold 
the 100 shares you bought, returning again to 
delta-neutral but with a $100 “gamma trade” 
in your pocket (minus, of course, the day’s 
theoretical time decay of $60 and any trans-
action costs you may have incurred). 

How do you decide where to place your 
entry and exit points? There are no hard-
and-fast rules, but let’s review three ideas.

Dollars to cover. In our example, with a 
theta of 0.06, this position theoretically 
loses $60 overnight. So that becomes the 
hurdle. If you can average at least $60 per 
day in gamma trades, you can buy yourself 
some time while you wait for the vega move 
you’re expecting.

 
Pair with a technical analysis strategy. If 
you typically trade technicals, you might 
use them to help guide your entry and exit 
points. For example, as XYZ moves in the 
direction of the primary trend, you might 
hedge only a portion of your delta and let 
the rest run. Or, if you near a support or 
resistance level, you could pick a point just 
shy of it and flatten your delta.   

Trade the standard devi-
ation. Volatility and thus 
options prices are derived 
from probabilities of price 
movement. Without getting 
too geeky, vol is essentially 
a measure of annualized 

standard deviation. So, many dynamic gam-
ma hedgers use the daily standard deviation 
as a place to square up their deltas. But 
you don’t need to calculate it yourself. The 
thinkorswim® platform from TD Ameritrade 
can do it for you (see Figure 1).

KNOW THE GROUND RULES AND  
LIMITATIONS
This strategy is neither for the fainthearted 
nor the casual participant. You can’t just set 
it and forget it. And because this strategy 
touches on all the major greeks—delta, 
gamma, theta, and vega—there are lots of 
moving parts.

  Remember that no greek is constant. As 
you approach expiration, that theta number 
gets bigger, and so does the gamma number. 
At expiration, each option is either ITM or 
OTM. It’s either worth its intrinsic value 
and exercised, or it expires worthless. So 
the stakes get higher the closer you get to 
expiration. Even veteran gamma scalpers 
may liquidate or attempt to roll their posi-
tions before expiration.

Besides, if you’re trading gamma as part 
of a long vega strategy, you’ll likely want to 
move on well before expiration. Theta and 
gamma intensify as you approach expira-
tion, but vega decreases.    

Speaking of long vol, some traders like to 
let their deltas run a bit more on the upside 
(and tighten them on the downside), be-
cause vol tends to drift downward on market 

Doug Ashburn is not a representative of  
TD Ameritrade, Inc. The material, views, and opin-
ions expressed in this article are solely those of the 
author and may not be reflective of those held by 
TD Ameritrade, Inc. 

For more information on the risks of trading and 
trading options, see page 35, #1 & 2.

The paperMoney software application is for ed-
ucational purposes only. Successful virtual trading 
during one time period does not guarantee suc-
cessful investing of actual funds during a later time 
period as market conditions change continuously.

rallies and drift upward as markets break.
Gamma trading is a complex strategy, 

but one that can help you get in tune with 
the interplay among all those greeks. If  
you can master it, you might develop a 
deeper understanding of how options pric-
es move. If you’re used to trading options 
from the short side, dynamically hedging 
around a long options position might 
broaden your perspective. 

IN TODAY’S ONLINE ZERO-COMMISSION 
environment, you don’t need the big guns to 
be a gamma trader. You can start small with 
a few contracts per trade. Want to go even 
smaller? Fire up the paperMoney® platform 
and gamma scalp risk-free for a few expira-
tion cycles until you get the hang of it.

FIGURE 1: STANDARD DEVIATION. Some gamma traders use the daily standard deviation to indicate entry and 
exit points. Under Analyze > Risk Profile, select ±1σ and change the date to current day. The price points will 
display as a shaded box. Source: the thinkorswim platform from TD Ameritrade. For illustrative purposes only. 
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TA K E  AWAY: 
Learn how futures 
work, not just how 
to trade them.S AV V Y
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PHOTOGRAPHS BY 
DAN SAELINGER

B I G  I D E A :  THE FUTURES MARKET CAN 
OPEN NEW WORLDS FOR OPTION  
TRADERS, BUT IT CAN ALSO CARRY 
UNIQUE RISKS. SO BEFORE YOU DIVE IN, 
KNOW HOW THIS MARKET WORKS. 
WORDS BY BRUCE BLYTHE

F ET SU

O

TM51_Spring2021.indd   28TM51_Spring2021.indd   28 2021-02-24   11:18 PM2021-02-24   11:18 PM

http://tdameritrade.com


TM51_Spring2021.indd   29TM51_Spring2021.indd   29 2021-02-24   9:32 PM2021-02-24   9:32 PM



30 | tdameritrade.com | SPRING 2021

look at price and volume data, select the An-
alyze tab, enter the futures contract symbol, 
and the traded futures contracts will appear. 
To see all actively traded options contracts, 
expand the Option Chain (see Figure 1).  

FUTURES VS. EQUITIES
Unlike equities, each futures contract has 
an expiration date. Beginning traders might 
fear they’ll end up with 1,000 barrels of 
oil on their doorstep when their crude oil 
futures contract expires. Although it’s good 
to be aware of delivery, when traders buy 
a futures contract, they’re not necessarily 
buying the underlying asset—they’re sim-
ply buying an obligation to buy or sell the 
asset. But most futures contracts aren’t held 
to expiration. Trades can be closed or rolled 
into a later month.

Futures contracts are also leveraged; 
that means returns or losses can potentially 
amplify.  Because margin requirements are 
typically smaller for futures contracts, trad-
ers could control a larger futures position 
with relatively little money down. 

So, what’s actually happening when a 
futures contract is purchased? Traders 
post a good-faith deposit (initial margin 
requirement or performance bond) with 
their futures commission merchant to 
make sure each party (buyer and seller) can 
meet the obligations of the futures contract. 
Initial margin requirements vary depend-
ing on commodity and market volatility 
but are typically a small percentage of the 
notional value of the contract—often 5% to 
6%, or even less. That’s a lot lower than the 

reading this magazine, you’ve likely been 
trading stocks and options for a bit and been 
around the block a few times. But the futures 
market? Perhaps that’s where you’ve drawn 
the line. “Thanks, but I’m good” you might be 
thinking, right?

Understandable. Futures are a different 
animal. But you may be closer to the futures 
market than you realize. Did you drink cof-
fee this morning? Buy groceries this week? 
Refinance your mortgage this year? Guess 
what: If you said yes to any of these, in a way, 
you’ve already been a “participant” of sorts in 
the futures market.

Trading futures does come with potential 
benefits, such as diversification and portfolio 
hedging. But futures trading involves sub-
stantial risk and is not suitable for everyone. 
Like anything else, the more you know, the 
better. Let’s start with some of the basics.

FUTURES CONTRACTS—WHAT ARE THEY?
In a nutshell, a futures contract is an agree-
ment to buy or sell an asset at an agreed price 
at a specific time in the future. Many of these 
contracts are based on different commodi-
ties—grains, coffee, metals, livestock, sugar, 
oil and natural gas, or money itself (in the 
form of interest rate futures).

Futures contracts are “standardized” and 
have certain specs:

• Quality and quantity
•  Unit pricing and minimum price fluctua-

tion (aka tick size)
• Date and geographic location for phys-
ical “delivery” of the underlying (most 
contracts are liquidated before the deliv-
ery date; actual delivery never happens at 
TD Ameritrade)

The specs differ across products (see 
Table 1). For now, let’s focus on three com-
modities—crude oil, corn, and gold—and 
two not-so-commodities—stock indices (the 
E-mini S&P 500 Index) and interest rates 
(10-year Treasury note/bonds). 

Knowing the specs of each product helps 
you  analyze futures contracts. So, when you 
bring up a futures chart on the thinkorswim® 
platform from TD Ameritrade, you’ll know 
what a one-point move represents. And to 

50% leverage in equities under the Federal 
Reserve’s Regulation T, or “Reg T.” 

Because futures can be highly leveraged, 
it’s not necessary to tie up a lot of capital to 
hedge a large portfolio. Futures also make 
it easier to achieve short market exposure, 
as compared to stocks or exchange-traded 
funds (ETFs). Think crude oil prices will 
decline? A “sell” order initiates a short crude 
futures contract position. However, shorting 
a stock or ETF could mean borrowing those 
shares from your broker. That might involve 
paying interest charges, making sure you 
have a large enough account size, and ensur-
ing the shares are available for shorting. 

Say a trader holds a $500,000 portfolio and 
is concerned about the prospect of negative 
surprises in an upcoming earnings season. 
This trader might consider hedging about a 
third of that portfolio by selling (or shorting) 
one E-mini S&P 500 contract (/ES) by put-
ting up the initial margin (which was about 
$12,000 as of late 2020). Because the notional 
value of one E-mini S&P 500 contract is $50 
times the index price, with /ES at 3,500, the 
initial margin would represent about 7% of 
the notional value:

($50 x 3,500) = $175,000
$12,000/$175,000 = 0.069, or 6.9% 

If the S&P 500 drops 50 points, the trader 
might consider buying back, or “closing 
out,” that futures position. Hypothetically, 
a $2,500 gain in the futures position could 
help offset any unrealized portfolio losses, 
thereby hedging portfolio risk. By taking a 

IF YOU’RE

TABLE 1: STANDARDIZED BUT DIFFERENT. Know the contract specs for any futures contracts you want to trade. 
For illustrative purposes only.

Contract Contract Size Minimum Tick $ Value of
 One Tick

Maintenance
Margin*

Corn (/ZC) 5,000 bushels $0.0025 (1/4 cent) $12.50    

Crude oil (/CL) 1,000 barrels $0.01/barrel  $10 $2,000 – $3,500

Gold (/GC) 100 troy ounces $0.10/troy ounce  $10 $10,000

E-mini S&P 500 
Index (/ES)

$50 x S&P 500 
Index value

$0.25 index point   $12.50 $11,000

10-Year Treasury
Note (/ZN)

$100,000 (face 
value at maturity)

1/2 of 1/32 of one 
point

 $15.625 $1,400

*CME’s listed margin requirements as of December 2020.

$650 – $1,500
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position in the futures contract, traders can 
gain similar notional exposure while using 
less capital.

Important reminder: Because margin 
magnifies profits and losses, a trader could 
gain or lose more than the initial amount 

used to purchase the futures 
position. If prices move 
against a position, it could 
result in a margin call. That 
could mean adding more 
funds to the account or risk 
getting liquidated. 

Another big difference: Futures tend to  
be more volatile than many stocks. Many  
futures contracts don’t trade as actively as 
large stocks, and futures can experience 
sharp, sudden price swings. Volatility in fu-
tures can be from forces of nature—droughts, 
hurricanes, geopolitical tensions, etc.

HOW CAN EQUITY OPTION TRADERS  
BENEFIT FROM FUTURES?
Options and futures are both derivatives: 
Their values are derived from their un-
derlying asset. But there are differences 

Bruce Blythe is not a representative of  
TD Ameritrade, Inc. The material, views, and 
opinions expressed in this article are solely those 
of the author and may not be reflective of those 
held by TD Ameritrade, Inc. 

For more on the risks of trading and trading 
futures, see page 35, #1 & 3. 

between the two. One is the daily cash  
settlement of futures (in other words, dol-
lars, not gold bullion or barrels of oil). The 
value of a futures contract either makes or 
loses money at the end of the trading day. 
That can weigh on making a decision to ei-
ther hold or sell the position. Futures traders 
don’t have to worry about time decay (theta) 
whereas futures options traders do. 

Futures also provide nearly round-the-
clock access to markets or asset classes 
while equity options don’t. And futures can 
provide possible diversification benefits.

ANY TRADER READY TO GIVE FUTURES A 
try can start by creating a watchlist of the 
most liquid contracts. Knowing what the 
futures market is doing ahead of the equity 
market’s open could provide a head start to 
the trading day’s actions. Plus, it’s a great 
way to get to know futures.

FIGURE 1: FUTURES AND OPTIONS ON FUTURES.  On thinkorswim under the Analyze tab, type in the futures 
symbol to see the futures contracts listed and the Option Chain for each of the contracts below it. 
Source: thinkorswim from TD Ameritrade. For illustrative purposes only. 

UNIQUE WINDOW 
THROUGH FUTURES:  
TAKE A PEEK

EXPLORE

CHECK OUT
You may already
be participating 
in the futures 
markets. To find 
out how, read 
http://bit.ly/TT-
FutHdg

LEARN
Learn more about 
trading futures. 
Log in to your 
account at 
tdameritrade.com 
and, under the 
Education tab, 
select Futures > 
Fundamentals  
of Futures 
Trading > Start 
Course.

Futures
contracts

Options
on futures

TRADER 
GLOSSARY
TURN TO 
PAGE 33

For Stephanie Lewicky, senior manager,  
trader education, at TD Ameritrade, futures  
provide a fascinating “window” into global markets 
and world events that can inform and enlighten  
any trading strategy.

Stephanie, why is it  
important to keep an eye 
on the futures market  
and understand how  
futures work?
Futures trade nearly 
around the clock, which 
means contracts like the 
E-mini S&P 500 can  
indicate where cash equity 
markets might open. That 
can help traders “set up” 

for their day. Also, many 
market-moving events, 
such as economic reports 
and quarterly earnings, 
happen outside regular 
equity market hours. By 
following futures, you 
can gauge potential cash 
market reaction to, for 
example, a stronger- or 
weaker-than-expected 
earnings report.

How can the futures 
market provide critical 
insights for traders,  
even if they’re not  
trading futures?
Futures are woven into 
many aspects of our per-
sonal and work lives. Do 
you have a 401(k) that 
includes a basket of S&P 
500 stocks? Call up a 
12-month chart of E-mini 
S&P 500 futures—it may 
be a good indication of how 
your 401(k) is doing. How 
much will you pay to heat 
your home over the winter 
or fill your gas tank for a 
summer road trip? Is now a 
good time to refinance your 
mortgage, or should you 
wait? The futures market 
can provide insight to those 
questions too.

How can incorporating 
futures benefit an  
equity or equity options 
trading strategy?
Whether you’re trading eq-
uities or options on equities, 
futures can provide a handy 
tool to hedge an entire port-
folio, or just a portion, with 
a smaller amount of capital. 
For example, options on 
major tech stocks could be 
hedged with E-mini Nas-
daq-100 futures (or options 
on Nasdaq-100 futures). 
Also, recently launched 
“micro” versions of futures 
linked to the Nasdaq-100, 
S&P 500, and other indi-
ces offer a “smaller-bite” 
alternative to the traditional 
e-minis. (Micros are one-
tenth the size of traditional 
e-mini contracts.)
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• Say you’re convinced a stock will move to the 
upside. Premiums on the stock’s out-of-the-
money options are relatively high, so what’s 
there to lose? Well, in the options world, 
things don’t necessarily work out as planned. 
Many factors could catch you off guard, and 
a big one is a “volatility (vol) crush.” If you’ve 
been trading options for a while, you’re prob-
ably smirking, because chances are the vol 
crush has caught you by surprise at least once. 

WHAT IT IS AND WHY IT HAPPENS
A vol crush is a sudden drop in implied volatil-
ity (IV) that often happens after a significant 
event such as an earnings report, regulatory 
decision, or clinical trial outcome. And when 
it happens, it can bring down the value of an 
option quite a bit. Why?

An option has both intrinsic and extrinsic 
value, with the extrinsic value representing 
risk premium. Let’s focus on earnings as an 
example. As an earnings date approaches, 
there’s a lot of uncertainty about how much 

a stock’s price could move. This causes  
the extrinsic value of the option to rise, 
which often leads to higher IV and increased 
options premiums. 

The stock’s expected price move is already 
priced in to the options. But after earnings are 
released, there’s no more earnings “uncertain-
ty.” That component, which was priced in to 
the option, has fallen to zero, which is why we 
often see IV drop rapidly after earnings reports.

Remember IV is an approximation of how 
much a stock’s price is likely to change. So, 
if IV is high prior to earnings, it means the 
options on the stock will be relatively more 
expensive. If you buy options prior to earnings 
and the earnings results don’t do much to the 
stock price, IV may still see a significant drop. 
This could bring down the price of the op-
tions, and you could end up losing money on 
your positions.   

What if the stock price moves a lot after 
earnings? In that case, the drop in IV may not 
matter much, especially in options expiring 

soon after earnings. There’s little extrinsic 
value, and depending on which way it goes, 
you could make or lose money.

Although it’s possible to make profitable 
short-term trades that take advantage of a vol 
crush, it can be risky. 

SOME POTENTIAL WORK-AROUNDS
Options closest to expiration tend to be more 
sensitive. So, if you’re looking for less sensi-
tivity, you might consider options that expire 
further out because a vol crush may not impact 
them as much. But vega could be greater, all 
else equal, so you may see a larger value loss. 
Another workaround may be to compare IV to 
historical volatility. If IV is extremely high, you 
may want to wait until it falls closer to nor-
mal. And if you notice that IV is high, do your 
homework. It’s probably high for a reason.  
—Words by JAYANTHI GOPALAKRISHNAN
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Vol Crush?
It Could Be a Dealbreaker
Have you ever seen implied volatility drop so quickly it killed 
your trade? Here are a few risk management ideas to consider.
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HOW DO YOU SEE THE 
EXPECTED MOVE?  
On the thinkorswim® platform from 
TD Ameritrade, you can view the 
Market Maker Move (MMM) next 
to the price quote. It appears when 
front-month IV is higher than that 
of deferred months. The MMM 
represents a one standard deviation 
expected move. In other words, 
68.2% of the time the close can be 
within the MMM price range. And 
remember this is just an approx-
imation. The stock could end up 
moving much less or more than 
the expected move.

Jayanthi Gopalakrishnan is not a representative of 
TD Ameritrade, Inc. The material, views, and opin-
ions expressed in this article are solely those of the 
author and may not be reflective of those held by 
TD Ameritrade, Inc. 

For more information on the risks of trading and 
trading options, see page 35, #1 & 2.
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TRADER JARGON

 Delta

A measure of the sensitivity of an option to a 
$1 change in the underlying asset. All else 
being equal, an option with a 0.50 delta (for 
example) would gain $0.50 per $1 move up in 
the underlying. Long calls and short puts have 
positive (+) deltas, meaning they gain as the 
underlying gains in value. Long puts and 
short calls have negative (–) deltas, meaning 
they gain as the underlying drops in value.

Gamma

A measure of what an option contract’s delta 
is expected to change per $1 move in the 
underlying.   
 
Implied volatility

The market’s perception of the future vola-
tility of the underlying security and is direct-
ly reflected in the premium of an option.  
Implied volatility is an annualized number 
expressed as a percentage (such as 25%), is 
forward-looking, and can change.

In the money (ITM)

An option whose premium contains “real” 
value, i.e., not just time value. For calls, it’s any 
strike lower than the price of the underlying 
equity. For puts, it’s any strike that’s higher.   

Out of the money (OTM)

An option whose premium is not only all 
“time” value, but its strike is away from the 
underlying equity. For calls, it’s any strike 
higher than the underlying. For puts, it’s any 
strike that’s lower. 

Straddles (long)

A market-neutral, defined-risk position 
composed of an equal number of long calls 
and puts of the same strike price. The strategy 
assumes the market will break out one way or 
another, in which case a profit occurs when 
one side of the trade gains more than the 
other side loses. Break-even points are calcu-
lated by adding and subtracting the total debit 
to and from the strike price of the options.

  
Strangles (short straddle)

A market-neutral strategy with unlimited 
risk composed of an equal number of short 
calls and puts of the same strike price (strad-
dle) or two different strike prices (strangle), 
resulting in a credit taken in at the onset of 
the trade.  The strategy assumes the underly-
ing will stay within a certain range, in which 
case, as time passes and/or volatility drops, 
the options can be bought back cheaper than 
the credit taken in or expire worthless, 
resulting in a profit. Break-even points of 
either strategy at expiration are calculated 
by adding the total credit received to the call 
strike and subtracting the total credit re-
ceived from the put strike.

Theta

A measure of the sensitivity of options to 
time passing one calendar day. For example, 
if a long put has a theta of -0.02, the options 
premium will decrease by $2 per contract.

Vega

A measure of the sensitivity of options to a 
one percentage point change in implied 
volatility. For example, if a long option has a 
vega of 0.04, a one percentage point increase 
in implied volatility will increase the options 
premium by $4 per contract. 

Vertical spread

A defined-risk, directional spread strategy 
composed of a long and a short option of the 
same type (that is, calls or puts). Long verti-
cals are purchased for a debit, while short 
verticals are sold for a credit at the onset of 
the trade.  Long call and short put verticals are 
bullish, whereas long put and short call verti-
cals are bearish. The risk of a long vertical is 
typically limited to the debit of the trade, 
while the risk in the short vertical is typically 
limited to the difference between the short 
and long strikes minus the credit.

At the money (ATM)—An option whose strike is “at” the price of the 
underlying equity. Like out-of-the-money options, the premium of an  
at-the-money option is all “time” value.  

GOT 
      VOL?

24 | tdameritrade.com | SPRING 2021

TA K E  AWAY: 
Dynamically hedge a 
long options position  
to help pay for theta.P R O
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B I G  I D E A :  DO THE HEADWINDS OF TIME DECAY TURN YOU OFF FROM BUYING SINGLE OPTIONS ON  

STOCKS THAT MOVE AROUND A LOT?  WHAT IF YOU COULD TURN THAT HEADWIND INTO A TAILWIND 

BY TRADING THOSE STOCK MOVES? TURNS OUT YOU CAN. WORDS BY DOUG ASHBURNTRADE
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CAPICHE?

• Many traders leap before they 
look, eager to get in on the hype. 
At times when stocks may post 
double- or triple-digit gains, it’s 
tempting to jump in to a stock 
even if it goes against your trading 
plan. Sure, those trades can some-
times hit gold. But often, they 
strike rocks. 

So, if you’re tempted to toss 
your playbook and throw a long 

bomb on the latest initial public 
offering (IPO), or something you 
read about on social media, you 
risk a pick-six. Successful trad-
ers have rules and stick to them, 
whether those rules are based on 
volatility, probability, technical 
analysis, or other factors. 

Of course, there may be times 
you break the rules. And once you 
break your guidelines the first 

time, it gets easier to do it again. 
Eventually, your portfolio no lon-
ger matches your goals, and you 
become an undisciplined trader 
chasing butterflies. 

There’s nothing wrong with 
putting a little money into some 
of these hype stocks. But for 
bread-and-butter trades, you 
should know why you’re buying 
the stock and how it fits into your 
overall portfolio. 

Consider the following three 
scenarios, which should set off 
alarm bells that you’re leaving 
your playbook on the bench.

Buying a stock you read about 
on social media. Stock market 
chatter on social media isn’t 
necessarily great for assessing 
a company’s value or its shares. 
Although it’s hard to ignore a 
stock everyone’s talking about, 
when you get caught up in that 
chatter, take a breather and do 
a quick review of your trading 
plan. Does this stock-picking 
strategy fit your goals? If so, go 
back to figuring out your entry 
point. If not, steer clear. 

Getting allured by an IPO. There’s 
nothing like the sizzle of an IPO, 
with a bell ringing and TV inter-
views on the big day. But don’t 
jump in too quickly. IPOs tend to 
be volatile, and the market often 
has trouble pricing them proper-
ly. For example, how would you 
price a travel company that’s hint-
ing at an IPO, despite bleeding 
hundreds of millions of dollars a 
quarter because of a pandemic? 

Then there are all those insid-
ers who’ve been waiting years to 
get their hands on the stock so 

they can sell it. In this scenario, 
you’re fighting upstream. You 
may be better off waiting for the 
dust to settle. Then make sure the 
stock satisfies everything in your 
trading plan before adding it to 
your portfolio. 

Making an after-hours “sympathy” 
trade. Don’t get too cute with 
so-called “sympathy” trades. 
Let’s say you follow a popular 
tech company that reports big 
earnings after a close. Then you 
see shares of its suppliers getting 
bids and decide to hop on board. 
Maybe it’s a company you’ve nev-
er heard of, but hey, they’re tied to 
your favorite tech com- 
pany’s ecosystem, so what’s there 
to lose? 

YOUR MONEY, FOR ONE THING. 
Remember the trading plan you 
worked so hard to create? Dig it 
out and ask yourself if the stock 
is a fit. Does it bring you closer 
to your goals, or are you chasing 
higher shares because everyone 
else is? Know these answers long 
before you trade or you risk enter-
ing P.T. Barnum territory. As he’s 
rumored to have said, “There’s a 
sucker born every minute.” Don’t 
be one. —Words by DAN ROSENBERG

Why Are You Getting 
In a Trade? 
Are you jumping in and out of stocks, trying 
to hitch a ride on the next big mover? Here 
are three really bad ideas. 

Dan Rosenberg is not a representative 
of TD Ameritrade, Inc. The material, 
views, and opinions expressed in this 
article are solely those of the author 
and may not be reflective of those held 
by TD Ameritrade, Inc. 

For more information on the risks of 
trading and trading options, see page 
35, #1 & 2.
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OPTIONS STRATEGIES
Trading options involves unique risks and 
is not suitable for all investors. 

Spreads, condors, butterflies, straddles, 
and other complex, multiple-leg options 
strategies can entail substantial trans-
action costs, including multiple commis-
sions, which may impact any potential 
return. These are advanced options 
strategies and often involve greater risk, 
and more complex risk, than basic options 
trades. Be aware that assignment on short 
options strategies discussed in this article 
could lead to unwanted long or short 
positions on the underlying security. 

The maximum potential reward for a 
long put is limited by the amount that the 
underlying stock can fall. Should the long 
put position expire worthless, the entire 
cost of the put position would be lost.

When trading short options strategies, 
there is a risk of getting assigned early 
on the options sold, even if they go in the 
money by $0.01, obligating you to deliver  
shares you don’t own (in the case of a  
short call) or purchase shares (in the case 
of a short put). 

The risk of loss on an uncovered short 
call options position is potentially unlim-
ited because there is no limit to the price 
increase of the underlying security. Option 
writing as an investment strategy is abso-
lutely inappropriate for anyone who does 
not fully understand the nature and extent 
of the risks involved.

Short naked put and cash-secured put 
strategies include a high risk of purchas-
ing the corresponding stock at the strike 
price when the market price of the stock 
will likely be lower.  

Short naked options strategies involve 
the highest amount of risk and are only 
appropriate for traders with the highest 
risk tolerance.  

A covered call strategy can limit the 
upside potential of the underlying stock 
position, as the stock would likely be 
called away in the event of a substantial 
stock price increase. Additionally, any 
downside protection provided to the relat-
ed stock position is limited to the premium 
received. (Short options can be assigned at 
any time up to expiration regardless of the 
in-the-money amount.)

 1
GENERAL DISCLAIMER
The information contained in this article is not intended to be investment advice and is for 
illustrative purposes only. Be sure to understand all risks involved with each strategy, including 
commission costs, before attempting to place any trade. Clients must consider all relevant risk 
factors, including their own personal financial situations, before trading. Past performance of a 
security or strategy does not guarantee future results or success.

Transaction costs (commissions and other fees) are important factors and should be consid-
ered when evaluating any options trade. Options are not suitable for all investors as the special 
risks inherent to options trading may expose investors to potentially rapid and substantial 
losses. Options trading is subject to TD Ameritrade review and approval. Please read Charac-
teristics and Risks of Standardized Options (http://www.optionsclearing.com/about/publi-
cations/character-risks.jsp) before investing in options.

It is not possible to invest directly in an index.

 3 
FUTURES
Futures trading is not suitable for all 
investors, as the risk of loss in trading fu-
tures is  substantial. Futures accounts are 
not protected by the Securities Investor 
Protection Corporation (SIPC). Futures 
and futures options trading services are 
provided by TD Ameritrade Futures & 
Forex LLC. Trading privileges are subject 
to review and approval. Not all clients 
will qualify.  

Futures and futures options trading  
are speculative and are not suitable for  
all investors. Please read the Risk  
Disclosure for Futures and Options  
prior to trading futures products  
(https://www.tdameritrade.com/retail- 
en_us/resources/pdf/TDA631.pdf ).

4
SPREAD DISCLOSURES
Options collar: The collar position in-
volves the risks of  both covered calls and 
protective puts.

Options covered call: The covered call 
strategy can limit the upside potential 
of the underlying stock position, as the 
stock would likely be called away in 
the event of a substantial stock price 
increase. Additionally, any downside 
protection provided to the related stock 
position is limited to the premium re-
ceived. (Short options can be assigned at 
any time up to expiration regardless of 
the in-the-money amount.) 

Options long put: The maximum potential 
reward for a long  put is limited by the 
amount that the underlying stock can fall. 
This strategy provides only temporary 
protection from a decline in the price of 
the corresponding stock. Should the long 
put position expire worthless, the entire 
cost of the put position would be lost.

IMPORTANT INFORMATION YOU NEED TO KNOW DISCLAIMER
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